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2 จดหมายขาวสํานักคอมพิวเตอร 

SWU Webmail เวอรชั่น 2 
 วราภรณ  วิยานนท 

swu.ac.th 

สํานักคอมพิวเตอรไดเปดบริการเว็บเมลเวอรชั่น 2 ชื่อ 

Squirrel Mail เมื่อวันที่ 13 สิงหาคม 2545 ซึ่งเว็บเมลเวอรชั่น
นี้มีคุณสมบัติที่อํานวยความสะดวกใหกับผูใชมาก 

@ 

โดยในบทความนี้จะขอกลาวถึงคุณสมบัติที่นาสนใจ ดังนี ้
Fetch mail 

Fetch mail เปนการดึงจดหมายจากเมลเซิรฟเวอรตัวอื่น
มาอยูในกลองจดหมายของคุณบนเครื่องเว็บเมล  คุณสมบัติ
นี้เพิ่มความสะดวกสบายใหกับผูใชที่มี account มากกวา
หนึ่ง ซึ่งสามารถตรวจสอบจดหมายทั้งหมดโดยผานเว็บเมลที่
เดียว ขั้นตอนเพื่อกําหนดคาเริ่มตน มีดังนี้ 
1. เลือก Options  Simple POP3 Fetch Mail และระบุ

คาเหลานี้ 
 Server เชน psm.swu.ac.th 
 Alias (ชื่อแฝงของเครื่องเซิรฟเวอร)  เชน psm 
 Username และ Password บนเครื่องเซิรฟเวอรที่
ระบุขางตน 

 Store in Folder กลองสําหรับรับจดหมาย  
− ทําเครื่องหมายที่ Leave Mail on Server หาก

ตองการคัดลอกจดหมาย 
− ทําเครื่องหมายที่ Check mail during login หาก

ตองการตรวจสอบจดหมายเมื่อล็อคอิน 
− ทําเครื่องหมายที่ Check mail during folder 

refresh หากตองการดึงจดหมายเมื่อมีการ refresh 
folder 

2. กดปุม Add Server 

หากไมไดระบุเวลาสําหรับดึงจดหมาย ก็สามารถดึงจดหมาย
ไดตามผูใชตองการโดย กดปุม Fetch บนแถบเครื่องมือ และ
เลือกเซิรฟเวอรที่ตองการดึงจดหมายเทานั้น ซึ่งขอแนะนําให
ใชวิธีนี้เพื่อเปนการลด Traffic การใชงานของเครือขาย 

Bookmark 
Bookmark ใชสําหรับเก็บ URL ของเว็บไซตที่นาสนใจ ซึ่ง

ชวยใหผูใชไมจําเปนตองจดหรือจํา URL ของเว็บไซตที่ 
ชื่นชอบ โดยทั่วไป Bookmark จะมาพรอมกับโปรแกรม
ประเภทบราวเซอร เชน IE หรือ Netscape แตการบันทึกนั้น
จะอยูบนเครื่องพีซีของผูใชเทานั้น หากผูใชใชงานเครื่องอื่น
จําเปนตองคัดลอกแฟมที่เปน bookmark ไปเก็บไวยังเครื่อง
ที่ใชงาน ซึ่งหากเก็บ URL ที่สนใจไวในระบบเว็บเมลนี้ ไมวา
จะอยูที่ใดก็ตามก็สามารถนํา bookmark ที่บันทึกไวมาเรียก
ใชได  

Filter 
Filter หรือตัวกรอง เปนอีกคุณสมบัติหนึ่งที่สามารถชวยให

ผูใชจัดการกับจดหมายที่สงยังผูใชไดอยางมีประสิทธิภาพ 
หลายทานคงพบกับจดหมายขยะ (Junk mail) ที่มาจาก
บุคคลที่ไมรูจัก ซึ่งเปนส่ิงที่รบกวนใจและสรางภาระใหกับ
การดูแลพื้นที่การใชงาน หากมีการกําหนด filter ปญหาเหลา
นี้ก็จะลดลง 
กอนที่จะกําหนด filter จดหมายนั้น ส่ิงแรกที่ควรคํานึงคือ 

รูปแบบที่จะใชเปนเงื่อนไขในการกรอง เชน ไมตองการรับ 
จดหมายที่สงจาก spam@virus.com หรือไมตองการรับ 
จดหมายที่มี Subject เปนขอความ Nimda Virus!!! เปนตน 
เมื่อไดรูปแบบเงื่อนไขแลว ปฏิบัติตามขั้นตอนทั้ง 4 ขอจาก
เมนู Filters เพียงเทานี้จดหมายเหลานี้ก็จะไมมากวนใจ 

ไปพักรอน (Vacation) 
หากมีธุระหรือไปเที่ยวในชวงระยะเวลาหนึ่งซึ่งไมสามารถ

ตรวจจดหมายได ระบบเว็บเมลสามารถแจงกลับผูสงดวยขอ
ความที่กําหนดได เพียงเลือกใชเมนู Filters  เลือก Role 
Type เปน All messages จากนั้น ระบุ Vacation และขอ
ความที่ตองการตอบกลับผูสง เทานี้ผูสงก็จะไดรับทราบวา
คุณไมสามารถตรวจจดหมายได 
บทสรุป 
คุณสมบัติที่กลาวมานี้ชวยอํานวยความสะดวกใหผูใชและ

จัดการกับจดหมายไดอยางมีประสิทธิภาพ นอกจากนี้ยังมี
คุณสมบัติที่นาสนใจในเว็บเมลนี้อีกมาก ซึ่งสามารถอานขอ
มูลเพิ่มเติมไดที่ Quick Start Guide ในหนาเว็บเมล  
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ระบบภาระงาน (Workload System) 
 พีระ แพทยประเสริฐ 

ในชวงของการประเมินผลการปฏิบัติงาน ทานอาจจะเคยมี
ปญหาในการเตรียมเอกสารเพื่อใชในการประเมินบุคลากร 
ตองรื้อคนเอกสารมอบหมายงาน ตองนั่งนึกจิตนาการวาที่
ผานมาเราทําอะไรมาบาง หรือที่หนักไปกวานั้นคือ จําไมไดวา
เราทํางานอะไรบาง ซึ่งสงผลใหผลการประเมินออกมาไมเปน
ที่นาพอใจ ทั้ง ๆ ที่มีผลงานมากมาย  
ในการนี้ สํานักคอมพิวเตอรไดเล็งเห็นถึงความสําคัญของ

การพัฒนาระบบการจัดเก็บขอมูลการปฏิบัติงานของบุคลากร
ตามการปฏิบัติงานจริง เพื่อเปนการประกันคุณภาพการ
ทํางานของบุคลากร และสามารถนําขอมูลมาใชในการ 
ติดตามงาน รายงานผลการดําเนินงานตามความเปนจริง  
และสามารถวิเคราะหขอมูลเพื่อการวางแผน  ปรับปรุงงาน
และพัฒนาบุคลากรได  จึงไดมีโครงการระบบภาระงานขึ้น  
ซึ่งเปนหนึ่งในโครงการระบบอินทราเน็ตสํานักคอมพิวเตอรอัน
เปนระบบที่ใชบริหารงานภายในสํานักคอมพิวเตอร เชนเดียว
กับระบบงานอื่น ๆ ไดแก ระบบงานการปฏิบัติงานลวงเวลา 
ระบบการมีการใชคอมพิวเตอรและอุปกรณ  
มารูจักระบบภาระงาน 
ระบบภาระงานเปนระบบที่ออกแบบมาใหบุคลากรทุกคน

บันทึกการปฏิบัติงานของแตละคนทุกวัน  โดยแตละวันจะใช
เวลาไมมากในการบันทึก  ในการบันทึกจะมีการบันทึก
ประเภทของภาระงานที่ทําตามรหัสที่กําหนดของโครงสราง
ประเภทภาระงานของสํานักคอมพิวเตอร จํานวนชั่วโมงที่ใช
ในการปฏิบัติงานสําหรับงานแตละประเภท  และรายละเอียด
โดยยอของการปฏิบัติงาน    
นอกจากการบันทึกการปฏิบัติงานแลวระบบภาระงาน

สามารถบันทึกเวลาเขา-ออกงานรายวัน ได 
ลักษณะการประมวลผลขอมูลของระบบจะเปนแบบ Web-

based  ซึ่งผูใชสามารถใชงานไดงายผานทางเบาวเซอร เชน 
I.E. เปนตน  ดังนั้นถาเครื่องคอมพิวเตอรตออยูบนเครือขาย
บัวศรีจะสามารถใชระบบนี้ไดทันที  
การออกแบบหนาจอ เปนแบบใหผูใชสามารถเขาใจงาย

มากที่สุดหรือที่เรียกวา User friendly  พัฒนาโดยใช
เทคโนโลยี  ASP  และใชฐานขอมูล Access  
ระบบภาระงานระยะที่หนึ่งไดเริ่มนําระบบเขามาให

บุคลากรสํานักคอมพิวเตอรใชงานเมื่อวันที่ 1 กรกฎาคม 2545  
โดยไดรับความรวมมือและการตอบรับเปนอยางดีจาก
บุคลากรทุกคนในการบันทึกขอมูลการปฏิบัติงานประจําวัน

เขาระบบ  ทําใหหัวหนาฝาย  และผูบริหารสามารถติดตามผล
การปฏิบัติงานของบุคลากรได   
การเขาสูระบบภาระงาน 
เนื่องจากระบบภาระงานเปนสวนหนึ่งของระบบอินทราเน็ต 

ดังนั้นผูใชระบบตองผานหนารหัสผานของระบบอินทราเน็ต 
ระบบอินทราเน็ตจะแสดงระบบที่
บุคลากรนั้นมีสิทธิเขาไดปรากฏขึ้น
มา เชน ระบบภาระงาน ระบบการ
ปฏิบัติงานลวงเวลา   

ระบบการมีการใชเครื่องคอมพิวเตอรและอุปกรณ เปนตน  
เมื่อเขาสูระบบภาระงานจะมีเมนูเพื่อเขาสูหนาจอกรอกขอ

มูลปฏิบัติงานตางๆ ซึ่งเมนูจะตางกันไปในแตละผูใช ขึ้นอยู
กับสิทธิการเขาถึงขอมูลของแตละคน 

 
รายงานที่ระบบออกให 
ในขณะนี้ตัวระบบสามารถออกรายงานสรุปบันทึกการ

ปฏิบัติงานรายบุคคลได ไมวาจะเปนรายวัน รายเดือน หรือ
ตามเงื่อนไขที่กําหนด  หัวหนาฝายมีสิทธิดูสรุปรายงานของ
บุคลากรในฝายตนเองได  ผูบริหารสามารถดูขอมูลไดทั้งหมด  
นอกจากนั้นแลวระบบยังสามารถจะออกรายงานแยกตาม
ประเภทภาระงานของแตละบุคคลเพื่อสามารถจะใชเปน 
ข อ มู ล ใน ก า ร เป รี ย บ เที ย บ ภ า ระ งา น ที่ ม อ บ ห ม าย  
(job description) กับงานที่ปฏิบัติจริง   
การประเมินระบบ 
ระบบนี้ไดเริ่มใชในการเก็บขอมูลการปฏิบัติงานของ

บุคลากรสํานักคอมพิวเตอรในภาคการศึกษาที่ 1/2545  เมื่อ
ส้ินสุดภาคการศึกษาจะไดมีการประเมินผลการใชระบบเพื่อ
การปรับปรุง  และคาดหวังวาระบบสามารถจะขยายผลไปให
หนวยงานอื่นที่สนใจนําไปใชได   

 



4 จดหมายขาวสํานักคอมพิวเตอร 

             ระบบควบคุมการใชงานเครื่องไมโครคอมพิวเตอร 
จากสวนกลาง                                

                                                                                              สันติ  สุขยานันท และ  สรายุธ กัณหารี
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สํานักคอมพิ วเตอรได ใหบ ริการหองปฏิบัติการทาง
อมพิวเตอรสําหรับการเรียนการสอน  และการบริการทั่วไป  
กนิสิตและบุคลากรในมหาวิทยาลัย   ปญหาที่พบอยูเสมอ
ือการใหบริการและบํารุงรักษาเครื่องคอมพิวเตอรใหพรอม
ชงานตลอดเวลา  และความเปนมาตรฐานของระบบและ
อฟตแวร เนื่องดวยผูใชสามารถที่จะเปลี่ยนแปลงอะไรก็ไดใน
ครื่องไมโครคอมพิวเตอร  ทําใหตองสูญเสียเวลาและเจาหนา
ี่ในการดูแลรักษาเปนอันมาก อีกทั้งเปนการลําบากมากใน
ารควบคุมมาตรฐานการใชงาน  
สํานักคอมพิวเตอรจึงไดหาแนวทางแก ไข  โดยไดนํา

ปรแกรมบริหารและจัดการระบบจากสวนกลางมาทดลองใช 
พื่อที่จะทําใหการบริหารจัดการเครื่องคอมพิวเตอรในหอง
ฏิบัติการมีประสิทธิภาพยิ่งขึ้น  อีกทั้งเปนการแบงเบาภาระ
ละลดการสูญเสียเวลาในการทํางานของเจาหนาที่อีกดวย  
enworks ระบบควบคุมจากสวนกลาง 
Zenworks  เปนโปรแกรมจัดการระบบควบคุมการใชงาน

มโครคอมพิวเตอรลูกขายจากสวนกลาง  ทํางานภายใต
ะบบปฏิบัติการ  Novell Netware 5.1   ระบบจะจัดเก็บขอ
ูลของทรัพยากรทุกชนิดในระบบ เชน  ผูใชระบบ  ขอมูลของ
มโครคอมพิวเตอรลูกขายที่ควบคุม    ซึ่ งเรียกวา   NDS  
Novell Directory Service)  คุณสมบัติที่สําคัญของระบบมี
ังนี้ 
1. มีระบบการบริหารซอฟตแวรจากสวนกลาง  เชน 

สามารถจะลงซอฟตแวรจากสวนกลางได ซอฟตแวร
สามารถซอมแซมตัวเองโดยอัตโนมัติเมื่อเกิดการเสีย
หาย  มีระบบสถิติรายงานการใชซอฟตแวร 

2. มีระบบการบริหารเครื่องไมโครคอมพิวเตอรลูกขาย  
เชน ระบบสามารถเก็บขอมูลคุณสมบัติของฮารดแวรได
อัตโนมัติ  เชน  มี CPU รุนใด  มีหนวยความจําหลัก
แบบใดและจํานวนเทาใด มีฮารดดิสกความจุเทาใด มี
ระบบปฏิบัติการรุนใด และมีซอฟตแวรการใชงานใด
บางในเครื่องลูกขายแตละเครื่อง  และระบบสามารถจะ
ออกรายงานสถิติได 

3. มีระบบการบริหารระยะไกลอัตโนมัติ  นั่นคือเจาหนาที่
สามารถจะเขาไปดูปญหาของเครื่องลูกขายในระบบที่
เกิดขึ้นที่ใดก็ไดจากสวนกลาง  

4. มีระบบการ Monitor หนาจอการใชงานของเครื่อง 
ลูกขายจากสวนกลาง 

การทดสอบและทดลองใชระบบ 
ไดมีการติดตั้งและทดสอบระบบในภาคฤดูรอนปการศึกษา 

2544  และนําระบบนี้มาใชจริงในภาคการศึกษาที่ 1/2545 
(เดือนมิถุนายน)  ในหองปฏิบัติการคอมพิวเตอร (หอง16-
309) สํานักคอมพิวเตอร 
ผลการใชงานหลังจากที่ไดติดตั้งระบบควบคุมการใชงาน

เครื่องไมโครคอมพิวเตอรจากสวนกลาง ไดผลเปนที่นาพอใจ
ระดับหนึ่ง และจะนําไปใชกับหองปฏิบัติการคอมพิวเตอรของ 
สํานักคอมพิวเตอร หองอื่น ๆ ตอไป   
ผลที่คาดวาจะไดรับ 
เมื่อมีการนําระบบควบคุมการใชงาน เครื่องไมโคร

คอมพิวเตอร จากสวนกลางมาใชงานไดอยางเต็มรูปแบบ ส่ิง
ที่คาดวาจะไดรับคือ 

1. เครื่องทุกเครื่องในหองปฏิบัติการการเรียนการสอนจะมี
มาตรฐานเดียวกันทําใหผูสอนแกปญหาที่เกิดขึ้นได 
งายขึ้น 

2. การบํารุงรักษาเครื่องไมโครคอมพิวเตอรลูกขายทําได
อยางมีประสิทธิภาพ   

3. การจัดเก็บขอมูลเกี่ยวกับเครื่องคอมพิวเตอรลูกขายเปน
ไปแบบอัตโนมัติ  ทําใหสามารถมีขอมูลที่ถูกตอง ทัน
เวลาการใชงาน  สําหรับการบํารุงรักษาเครื่อง และการ
วางแผน 

4. ประหยัดแรงงานและการบริการเปนมืออาชีพมากขึ้น 
 
          
 

NDS 
 

 
 

บริการ คือ งานสําคัญของเรา  



ปที่ 6 ฉบับที่ 3 (กรกฎาคม - สิงหาคม 2545) 5 

.COM ไทยตําบลดอทคอม 
 สาโรช  เมาลานนนท 

สํานักคอมพิวเตอรไดมีโอกาสจัดฝกอมรม “โครงการ
พัฒนาผูนําชุมชนดานเทคโนโลยีสารสนเทศ“ ใหกับผูนําชุม
ชนของตําบลสาริกา และตําบลปากพลี อันเปนสวนหนึ่งของ 
“โครงการนํารองการสรางเครือขายระหวางสถาบันอุดมศึกษา
กับชุมชนจังหวัดนครนายกเพื่อพัฒนาความเขมแข็งของชุม
ชนและเศรษฐกิจฐานราก” ซึ่งทําใหผมตองสืบคนขอมูลบน
อินเตอรเน็ต เพื่อศึกษาวามีใครทําอะไร เกี่ยวกับการนํา
เทคโนโลยีสารสนเทศลงไปสูชุมชนระดับตําบลกันบาง ก็ได
พบเว็บไซตที่นาสนใจ 2 แหง และโครงการอินเตอรเน็ตตําบล 
ไทยตําบลดอทคอม 

ประเด็นที่นาสนใจของเว็บไซตไทยตําบลดอทคอม 
(http://www.thaitambon.com) คือ หนึ่ง เจาของเว็บไซตนี้
คือ พ.ต.ท.ทักษิณ ชินวัตร สอง ไดทําการเก็บรวบรวมขอมูล
พ้ืนฐานของตําบลตาง ๆ ไวถึง 5,440 ตําบล สาม ไดรวบรวม
ขอมูลผลิตภัณฑของตําบลตาง ๆ ไวถึง 17,383 รายการ  และ 
สี่ รวบรวมขอมูลแหลงทองเที่ยวของตําบลตาง ๆ ถึง 7,097 
แหง นอกจากในแงของการเก็บรวบรวมขอมูลอยางกวาง
ขวางและเปนระบบแลว ในแงทางเทคนิคของการออกแบบ
เว็บไซต ก็จัดทําไวไดอยางดี ขอมูลสินคาตําบลตาง ๆ มีภาพ
ประกอบ ราคา หมายเลขโทรศัพท และสถานที่ติดตอ เพียง
พอใหสามารถทําการติดตอซื้อขายกันไดอยางงาย ๆ นอกจาก
นั้นยังมีการเตรียมการเพื่อพรอมที่จะจัดทําในลักษณะพาณิชย
อิเล็กทรอนิกสใหกับชุมชนในระดับตําบลกันไดตอไป 

ไทยกัฝดอทเน็ต 
อีกเว็บไซตหนึ่งเปนของโครงการรัฐบาลอิเล็กทรอนิกส ที่

พยายามจะสรางมิติใหมของหนวยงานของรัฐในลักษณะ ที่
เดียว ทันใด ทั่วไทย ทุกเวลา เปนการสรางโอกาสใหประชา
ชนทุกคนไดเลือกใชบริการที่หลากหลายผานอินเตอรเน็ต รัฐ
ใหขอมูลกับประชาชนไดมากขึ้น ลดความยุงยากของ 

กฎเกณฑ เกิดการโปรงใสในการทํางาน ชวยลดชองวางและ
ความเหลื่อมล้ํา โดยใชประโยชนจากเทคโนโลยีสารสนเทศ
เปนเครื่องมือใหเกิดความเสมอภาคและเทาเทียม กระแสของ
รัฐบาลอิเล็กทรอนิกสนับวามาแรง เนื่องจากการกาวไปสูรัฐ
บาลอิเล็กทรอนิกสจะทําใหเปลี่ยนแปลงกระบวนการทํางาน 
และการใหบริการของภาครัฐ เพื่อใหมีประสิทธิภาพดีขึ้นกวา
เดิม ทุกทานสามารถทดลองเขาไปเยี่ยมชมประตูสูเครือขาย
สารสนเทศภาครัฐไดแลวที่ http://www.thaigov.net 

อินเตอรเน็ตตําบล 
โครงการอินเตอรเน็ตตําบล เกิดขึ้นดวยความมุงหวังของ

รัฐบาล ในการเสริมสรางความเขมแข็งใหแกการปกครอง
สวนทองถิ่น โดยอาศัยเทคโนโลยีสารสนเทศเปนเครื่องมือใน
การเขาถึงขอมูลขาวสารใหกับทุกตําบล เปาหมายในป 2546 
จะดําเนินการติดตั้งอินเตอรเน็ตตําบลใหครบทุกตําบลจํานวน 
6,745 แหงทั่วประเทศ ประเด็นที่สําคัญของการทํา
อินเตอรเน็ตตําบลก็เพื่อใหประชาชนสามารถเขาถึงขอมูลขาว
สารและบริการของรัฐไดอยางทั่วถึงและเทาเทียม 
บททิ้งทาย 

ทั้งสามโครงการที่ยกมาขางตนนี้ เปนโครงการที่เกื้อกูลกัน 
หากเปรียบใหอินเตอรเน็ตตําบลเปนพื้นแผนดิน ไทยกัฝดอท
เน็ตเปนปุยอินทรียธาตุ และไทยตําบลดอทคอมเปนตนไม ซึ่ง
ตนไมนี้ยังขาดน้ํา   และมหาวิทยาลัยก็สามารถจะเสริมใหตน
ไมไทยตําบลดอทคอมเจริญงอกงามไดดียิ่งขึ้น โดยทํา
มหาวิทยาลัยใหเปน e-University โดยเริ่มจากการนําความรู
ตาง ๆ มากมายในมหาวิทยาลัย ใหมาอยูในสื่ออิเล็กทรอนิกส
ใหมากขึ้น ขอมูลขาออกจากมหาวิทยาลัยสูชุมชนอินเตอรเน็ต
ตําบลจะไดมากขึ้น ถาเปนเชนนี้ได มหาวิทยาลัยคงเปรียบ
เปนสายฝนรดลงบนพื้นแผนดินกันไดบางกระมัง  

  

 



6 จดหมายขาวสํานักคอมพิวเตอร 

คอมพิวเตอรและเครือขายกับงานสํานักงาน 
การใช Microsoft Word อยางมีประสิทธิภาพ ดวย Style และ Template 

 สุณี  รักษาเกียรติศักดิ์ 

Microsoft Word หรือ Word เปนซอฟตแวรที่เปนที่นิยมใช
กันมากในการพิมพเอกสาร และอาจกลาวไดวาผูใชสวนใหญ
ยังไมรูจักการใช Word ที่ถูกตอง เชน การใชตนแบบยอหนา 
(style) และตนแบบเอกสาร (template) ในการพิมพเอกสาร 
หรือการทําสารบัญหนาอัตโนมัติ  
ตนแบบยอหนาและตนแบบเอกสาร 
หากผูใชสังเกตเมื่อเรียกโปรแกรม Word มาใช  Word จะ

นําตนแบบเอกสารที่เปน Blank Document มาให (ชื่อ 
Normal.dot)  (ลองเลือก File -> New จะเห็น Blank 
Document  อยูในหมวด General) 
ใน Blank Document  หรือตนแบบเอกสาร Normal.dot นี้ 

จะมีตนแบบยอหนาใหใช เชน Heading 1, Heading 2, 
Heading 3, และ  Normal  ซึ่งไดรับการจัดรูปแบบ (format) 
ไวแลว  ซึ่งอาจจะไมตรงตามความตองการของผูใช  ผูใชก็
สามารถจะเปลี่ยนไดใหตรงตามรูปแบบที่ตองการและบันทึก
เก็บไวใชงาน  ดังนี้ 

1. เลือก Format -> Style   
2. เลือก Style ที่ตองการปรับแตง  เชน  Heading 1  แลว

เลือก  Modify  -> Format  -> Font/Paragraph  ตามที่
ตองการ  และหากตองการใหมีการเปลี่ยน Style ในตน
แบบเอกสารปจจุบัน  เชน  Normal.dot  ก็ตองเลือก  
Add to template (ไมตองเลือกหากตองการเปลี่ยน
เฉพาะ  Style ของเอกสารปจจุบัน) 

3. เมื่อไดปรับแตงทุก Style  ตามที่ตองการแลว และเลือก
การกําหนดคาเริ่มตนอื่น ๆ ของเอกสาร เชน File -> 
Page Setup ตามที่ตองการ หากตองการใหเปนตน
แบบเอกสารใหม ใหทําการบันทึกตนแบบอันใหมนี้ โดย
เลือก  Save As  และเลือก  Save as type: เปน 
Document Template  และตั้งชื่อตนแบบเอกสารใหม 
จัดเก็บลงโฟลเดอรที่ตองการ  (จะอยูในโฟลเดอร  
General หรือตั้งโฟลเดอรใหมก็ได) 

การเลือกใชตนแบบเอกสารและตนแบบยอหนา 
หากตองการเลือกใชตนแบบเอกสารอื่นที่ไมใช  Blank 

Template (Normal.dot)  ใหไปที่  File -> New  แลวเลือกตน
แบบที่ตองการ 
ในตนแบบเอกสารที่เลือกจะมีตนแบบยอหนาใหเลือกใช 

(ปุมซายสุดบนแถบเครื่องมือจัดรูปแบบ-Formatting 

Toolbars)  กอนที่จะพิมพยอหนาใดควรเลือกตนแบบยอหนา
นั้นมากอนแลวจึงพิมพ  โดยเปดรายการตนแบบยอหนา 
ทั้งหมดและเลือกตนแบบที่ตองการ   
ตนแบบยอหนาจะมี 2 ประเภทคือ ยอหนาที่เปนหัวเรื่อง 

เชน  Heading 1, Heading  2, Heading 3 เปนตน  และยอ
หนาที่เปนเนื้อเรื่อง  เชน  Normal,  Body Text, Body Text 
First Indent, List, List Bullet  เปนตน  ซึ่งชื่อตนแบบตาง ๆ 
เหลานี้  Word มีใหแลว (ใน  Format -> Style  เลือก List: All 
Style)  เพียงแตเราเลือก Style ที่ตองการและปรับรูปแบบตาม
ที่ตองการเทานั้น   
หากเราตองการเปลี่ยนรูปแบบของยอหนาหนึ่งไปเปนอีก

ยอหนาหนึ่งก็ทําไดโดยวางเคอรเซอรที่ยอหนาที่ตองการและ
เลือกตนแบบยอหนาที่ตองการ  ยอหนานั้นก็จะเปลี่ยนตามรูป
แบบใหมที่เลือก 
ขอดีของการใชตนแบบเอกสารและตนแบบยอหนา 

1. เกิดความคงเสนคงวา (consistency) ในการพิมพ
เอกสาร  (ผูใชสวนใหญจะไมรูจักการใชตนแบบยอหนา 
โดยทุกยอหนาจะเปน Normal หมด แตมีรูปแบบที่แตก
ตางกันไป เพราะผูใชจัดรูปแบบยอหนาแตละยอหนา
เองตามที่ตองการ  ซึ่งอาจจะเกิดวาหัวขอใหญของหนา 
5 มีรูปแบบไมเหมือนหัวขอใหญของหนา 10 เปนตน) 

2. การเปลี่ยนแปลงเอกสารทําไดงาย  เชน  สมมติมีหัวขอ
ใหญอยู  10 แหงในเอกสาร และตองการที่จะเปลี่ยน
ลักษณะและขนาดของตัวพิมพ (font)  ถาไมไดใช Style 
ก็ตองทําการเปลี่ยน 10 ที่ แตถาใช Style เชน Heading 
1 ก็เปล่ียนที่ Style Heading 1 ครั้งเดียว  ทุกยอหนา 
10 แหงที่เรียกใช Style Heading 1 ก็จะเปลี่ยนหมด 

3. ทําใหเกิดมาตรฐานเดียวกันในการพิมพเอกสาร  และ
ทําใหสามารถแบงงานการพิมพใหกับหลาย ๆ คนทําได 
และเมื่อนํามารวมกันก็ยังเปนรูปแบบเดียวกัน  นั่นคือ
ตองใหตนแบบเอกสารที่กําหนด Style ที่ตองการ  ใหแต
ละคนนําเอาไปพิมพ 

4. สามารถทําสารบัญหนาไดโดยอัตโนมัติ ถาใช Style หัว
เรื่อง เชน Heading 1, … โดยใหขึ้นหนาใหมแลวเลือก  
Insert -> Index and Tables (เลือก Tables) 

Download ตัวอยางตนแบบเอกสาร และคูมือการใชตน
แบบเอกสารในการพิมพหนังสือ /รายงานการวิจัย  ไดที่  
http://sot.swu.ac.th   
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เพ่ิมความปลอดภัยใหเครือขายดวย 
ระบบ Antivirus บน Mail Server  

 มหัทธวัฒน  รักษาเกียรติศักดิ์ 

ปจจุบันการใชงานอินเทอรเน็ตเปนไปอยางแพรหลาย และ
การรับสงจดหมายก็เปนบริการหนึ่งที่มักจะพบปญหามาก
เนื่องจากจะพบไวรัสที่ติดมากับจดหมายเปนจํานวนมาก ทํา
ใหเกิดความเสียหายกับเครื่องคอมพิวเตอร  หากผูรับจด
หมายเปดไฟลที่แนบมากับจดหมายที่ติดไวรัส   ความเสียหาย
ที่เกิดขึ้น เชนขอมูลในเครื่องคอมพิวเตอร เกิดการสูญหาย 
หรือถูกเปล่ียนแปลงไป  
สํานักคอมพิวเตอรไดเล็งเห็นถึงปญหาและไดหาวิธีในการ

แก ไขปญหาไวรัสในไฟลที่ แนบมากับจดหมาย  เพื่ อให 
จดหมายทุกๆฉบับปลอดภัยจากไวรัส ซึ่งทางฝายระบบ
คอมพิวเตอรและเครือขายไดเริ่มทําการติดตั้งซอฟตแวรที่ใช
ในการตรวจสอบไวรัสในไฟลที่แนบมากับจดหมาย   ในชวง
เดือนที่ผานมาสามารถตรวจจับไวรัสไดเปนจํานวนมาก ทําให
ขอมูลของผูใชที่อยูในเครือขายบัวศรีสามารถรับสงจดหมาย
ไดอยางปลอดภัย 
วิธีสังเกตไวรัสที่มากับจดหมายบนระบบเครือขาย 
กรณีที่ มีจดหมายจากบุคคลอื่นสงมาใหกับคุณแลวมี       

ไวรัสติดมากับไฟลที่แนบมาในจดหมายจะปรากฏดังรูป 
 

 
ตัวอยางจดหมายที่มีไวรัสติดมากับไฟลที่แนบมากับจดหมาย 

 

ระบบจะแจงผูรับปลายทางวา  มีผูสงจดหมายมาถึงซึ่งมี 
ไวรัสติดอยูกับไฟลที่แนบ ระบบเครือขายบัวศรีไมรับจดหมาย
ฉบับนั้น ทําใหผูรับปลายทางไดทราบถึงปญหาในกรณีที่ผูรับ
ปลายทางไมไดรับจดหมายจากผูสง และในขณะเดียวกัน
ระบบก็จะสงจดหมายทําการแจงเตือนกลับไปยังผูสงวา 
จดหมายที่สงมายังเครือขายบัวศรีติดไวรัส  ทําใหผูสงทราบ

ขอมูลและทําการแกไขกอนที่จะสงจดหมายในครั้งตอไป ดัง
รูป 

 
ตัวอยางของจดหมายแจงเตือนผูสงจดหมายที่ติดไวรัสมายัง
เครือขายบัวศรี 

ผลการตรวจสอบไวรัส 
หนึ่งเดือนที่ผานมาหลังจากติดตั้งระบบ antivirus นี้แลว 

พบวาระบบสามารถตรวจจับไวรัสที่มากับจดหมายไดมาก
กวา 2,000 ฉบับที่สงเขาและออกในเครือขายบัวศรี  ทําให
สามารถเพิ่มความปลอดภัยใหเครือขายและผูใชเครือขายได
ในระดับหนึ่ง  
สรุป 
การดําเนินการดังกลาวขางตนนั้นเปนสวนหนึ่งที่ชวยให

ระบบเครือขายบัวศรีมีความปลอดภัยจากไวรัสเพิ่มมากขึ้น  
แตอยางไรก็ดี  เครื่องคอมพิวเตอรของทุก ๆ คน ยังควรตอง
ติดตั้งโปรแกรม antivirus เพื่อตรวจสอบไวรัสอยูตลอดเวลา 
เนื่องจากวาไวรัสไมไดเขามาที่เครื่องคอมพิวเตอรจากการรับ
สงจดหมายเพียงอยางเดียว แตยังสามารถเขามาสูเครื่องของ
เราไดหลายวิธี เชน การอานไฟลจากแผนดิสกที่ติดไวรัส การ
ดาวนโหลดโปรแกรมจากอินเทอรเน็ต หรือจากการรับสงไฟล
ผานเครือขายกับเครื่องที่ติดไวรัส  เปนตน 
หลังจากอานบทความฉบับนี้แลว คิดวาคงจะตองตรวจ

สอบระบบ antivirus บนเครื่องคอมพิวเตอรของทุก ๆ คนกัน
บางแลวนะครับ  ซึ่งสามารถหาขอมูลเพิ่มเติมเกี่ยวกับไวรัสได
จากเอกสารโครงการเสวนาไอทีครั้งที่  2 โดยคลิกที่หัวขอ 
ITTalk จากหนาแรก Home Page ของมหาวิทยาลัย 
(http://www.swu.ac.th)  

 



8 จดหมายขาวสํานักคอมพิวเตอร 

ขาวกิจกรรมและบริการ 
สํานักคอมพิวเตอร 

การบรรยายทางวิชาการ 
สํานักคอมพิวเตอรไดจัดการบรรยาย เรื่อง “การสรางสื่อฯ 

Online บนระบบเครือขาย” ใหแกบุคลากรของสํานัก
คอมพิวเตอร และผูสนใจ  โดย Dr.Mike Laurence    จาก  
Brock University ประเทศแคนาดา ในวันที่ 17 กรกฎาคม  
2545  เวลา 9.00 – 16.00 น. ณ หอง 16-406 ชั้น 4  
อาคาร 16 สํานักคอมพิวเตอร  มศว ประสานมิตร 

 
โครงการเสวนาไอที (IT Talk) 
สํานักคอมพิวเตอร ไดจัดใหมีการเสวนาไอที(IT Talk) เพื่อ

นําเสนอ/บรรยาย ความรูในการใชเทคโนโลยีสารสนเทศ 
ในดานตางๆ จากบุคลากรภายในมหาวิทยาลัยและภายนอก
มหาวิทยาลัย  ทุกวันอังคาร เวลา 12.20 น ณ หอง 16-406 
ชั้น 4  อาคาร 16  สํานักคอมพิวเตอร  มีกําหนดการ ดังนี้ 
ครั้งที่ วันที่ หัวขอเสวนา 

24  3 ก.ย.45 ”ลินุกซทะเล ระบบปฏิบัติการ 
บนเครื่องเดสทอป” 

25 10 ก.ย.45 “การสราง Home page เพื่อการสืบคน
อยางมีประสิทธิภาพ” 

26 17 ก.ย.45 “การปรับแตงพื้นที่บนฮารดดิสก   
โดย Partition Magic” 

27  24 ก.ย.45 “การสราง Home page สวนตัว เปนเรื่องงาย” 
28   1 ต.ค.45 ”การสรางแฟมขอมูลเอกสาร อยางมี 

ประสิทธิภาพสูง โดย  Adobe Acrobat  
Multilanguage “ 

29   8 ต.ค.45 “มาเรียนรูการโคลนิ่งฮารดดิสกกันดีกวา” 
30 15 ต.ค.45 “หนวยความจําบนเครื่องคอมฯ ทํางานอยางไร” 
31 22 ต.ค.45 “การใชโปรแกรม Excel  ในสํานักงาน 

อยางมีประสิทธิภาพ” 

32 29 ต.ค.45 “การสรางเว็บเพจ  โดย  Macromedia 
Dreamweaver เบื้องตน” 

ดูรายละเอียด และ download เอกสารประกอบการ
เสวนาโดยคลิกที่หัวขอ ITTalk จากหนาแรก Home Page 
ของมหาวิทยาลัย (http://www.swu.ac.th) 
การฝกอบรม 
สํานักคอมพิวเตอรจัดอบรมผูนําชุมชนองคการบริหารสวน

ตําบล (อบต.) ตําบลสาริกาและปากพลี จังหวัดนครนายก 
ตามโครงการพัฒนาผูนําชุมชนดานเทคโนโลยีสารสนเทศ  
ภายใตโครงการนํารองการสรางเครือขายระหวางสถาบัน
อุดมศึกษากับชุมชนจังหวัดนครนายกเพื่อพัฒนาความเขม
แข็งของชุมชนและเศรษฐกิจฐานราก (โครงการในเขตพื้นที่
ภาคกลางตอนบน) ในวันที่ 19,26,27  สิงหาคม 2545 และ
วันที่ 2 กันยายน 2545 เวลา 8.00 – 17.00 น.  
ณ  สํานักคอมพิวเตอร  มศว  องครักษ 
รายงานการจัดทําเคาโครงการเรียนการสอนผานเว็บ 
สํานักคอมพิวเตอรไดเปดบริการจัดทําเคาโครงการเรียน

การสอน (Course Syllabus) ผานเว็บ ประจําภาคเรียน 
1/2545 ตั้งแตวันที่ 30 พฤษภาคม 2545  เปนตนมา 
มีหนวยงานใหความสนใจในการจัดทํา Course Syllabus  
ผานเว็บ ดังรายงานสรุปดังนี้ 
� ัดทํา Course Syllabus จํานวน 165 วิชา 
จาก  3,046 วิชา 
มีการจ

�  3 อันดับแรกที่จัดทําจํานวน Course 
Syllabus  สูงสุด 
หนวยงาน

 คณะวิทยาศาสตร 49 วิชา 
 คณะสังคมศาสตร 43 วิชา 
 คณะมนุษยศาสตร 41 วิชา  

ดูรายละเอียดไดโดยคลิกที่ Course Web Page จากหนา 
Home page ของมหาวิทยาลัย (http://www.swu.ac.th/)  
ดูรายงานที่  Status Reports 
บุคลากรหนาใหมผูใหบริการ 

  

นายนนทวิทย  คุมปากพิง เจาหนาที่บริหารงานทั่วไป 
นายชัยรัตน  รอดเคราะห พนักงานเครื่องคอมพิวเตอร 
นายถาวร  หงษทอง   พนักงานเครื่องคอมพิวเตอร 
นายสมภพ  ชื่นจันทึก นักวิชาการคอมพิวเตอร 
นางสาวสุวิมล  คงตระกูล นักวิชาการคอมพิวเตอร 
นายอนิวรรตณ  รัตนอุดม นักวิชาการคอมพิวเตอร � 
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